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About the Precipitation Module (TC-PRISMA)

As of Thermo-Calc version 2016a, TC-PRISMA is no longer a standalone program. It
is integrated into the Thermo-Calc Graphical Mode and considered an add-on
module called the Precipitation Module. It is also available for all platforms
(Windows, Mac and Linux). If you have older versions of the TC-PRISMA software
that you want to uninstall, follow the instructions to remove this program
component as described in the Thermo-Calc Installation Guide.

The Precipitation Module, previously referred to as TC-PRISMA, is an add-on module to the
core Thermo-Calc software. The Precipitation Module itself is a general computational tool for
simulating kinetics of diffusion controlled multi-particle precipitation processes in
multicomponent and multi-phase alloy systems.

Precipitation, formation of particles of a second phase, or second phases from a supersaturated
solid solution matrix phase, is a solid state phase transformation process that has been
exploited to improve the strength and toughness of various structural alloys for many years.
This process is thermochemically driven and fully governed by system (bulk and interface)
thermodynamics and kinetics.

Typically, a precipitation process has three distinctive stages: nucleation, growth, and
coarsening. However, under certain conditions, these can also happen at the same time. With
the Precipitation Module, the kinetics of concurrent nucleation, growth, and coarsening can be
simulated by calculating the evolution of the probability distribution of the particle number
densities, usually called particle size distribution (PSD). The simulation results can be used to
understand and guide how to obtain desirable precipitates with certain PSD or to avoid
undesirable precipitations during heat treatments of alloys such as aging and tempering. A
summary for the input and output of the Precipitation Module is shown.

Input and Output of the Precipitation Module

The Precipitation Module relies on CALPHAD-based software tools and databases to provide the
necessary bulk thermodynamic and kinetic data for phases in multicomponent systems. The
CALPHAD approach has been developed for more than 50 years and is routinely applied to
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design new alloys and optimize existing materials within various metal industries, such as steels
and alloys of nickel, titanium, aluminum and magnesium.

The power of this approach is due to the adopted methodology where free energy and atomic
mobility of each phase in a multicomponent system can be modeled hierarchically from lower
order systems, and model parameters are evaluated in a consistent way by considering both
experimental data and ab-initio calculation results. The Precipitation Module is directly
integrated into Thermo-Calc, a CALPHAD-based computer program for calculating phase
equilibrium. Another add-on module, the Diffusion Module (DICTRA) is available for diffusion
controlled phase transformation in multicomponent systems.

With Thermo-Calc and the accompanying thermodynamic and mobility databases, almost all
fundamental phase equilibrium and phase transformation information can be calculated
without unnecessary and inaccurate approximations. For example you can calculate:

l Driving forces for nucleation and growth

l Operating tie-lines under local equilibrium conditions

l Deviations from local equilibrium at interfaces due to interface friction

l Atomic mobilities or diffusivities in the matrix phase

In addition to bulk thermodynamic and kinetic data, a few other physical properties, such as
interfacial energy and volume, are needed in precipitation models. These additional physical
parameters can be obtained by experiments or other estimation models or first principles
calculations. Volume data for steels and nickel-based alloys have already been assessed and
included in TCFE, TCNI, and TCAL databases. The Precipitation Module has an estimation model
available for interfacial energy.

This guide is a supplement to the full Thermo-Calc documentation set. It is
recommended that you use the Online Help from within Thermo-Calc to navigate
all the content. See "Help Resources" on the next page to learn how to access this
information if you have not already done so.
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Help Resources
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'Online' Help: No Internet Required

To access online help in a browser, open Thermo-Calc and select Help → Online Help. The
content opens in a browser but uses local content so you don't need an Internet connection
except links to external websites.
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Context Help (Graphical Mode Only)

When you are in Graphical Mode, you can access feature help (also called topic-
sensitive or context help) for the activity nodes in the tree.

1. In the Project window, click a node. For example, System Definer.

2. In the lower left corner of the Configuration window, click the help button .

3. The Help window opens to the relevant topic.

The window that opens has the same content as the help you access in the browser. There are
these extra navigation buttons in this view.

l Use the buttons on the bottom of the window, , to
navigate Back and Forward (these are only active once you have started using the help
to load pages and create a history), to Close the window, and Reload the original
content.

Console Mode Help

Console Mode is for Thermo-Calc and the Diffusion Module (DICTRA).

In Console Mode at the command line prompt, you can access help in these ways:

l For a list of all the available commands in the current module, at the prompt type a
question mark (?) and press <Enter>.
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l For a description of a specific command, type Help followed by the name of the
command. You can only get online help about a command related to the current module
you are in.

l For general system information type Information. Specify the subject or type ? and the
available subjects are listed. This subject list is specific to the current module.
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Precipitation Module (TC-PRISMA) Options
The Precipitation Module, previously referred to as TC-PRISMA, is an add-on module to the
core Thermo-Calc software. A separate license is required to perform calculations for more
than two elements. Without it you are able to use the module in Demo Mode. See
"Demonstration (Demo) Mode" on page 14 to learn more.

Precipitation Simulation Template

A Precipitation Simulation template is available to all Thermo-Calc users.

If you are using the Precipitation Module in Demo Mode, see "Demonstration
(Demo) Mode" on page 14 for what is available to you.
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Using the Template

When you first open Thermo-Calc in Graphical Mode, on the My Project window, click the
Precipitation Simulation button to add a System Definer, Precipitation Calculator and Plot
Renderer to the Project tree.

Click the Precipitation Simulation button in the templates section to add these nodes to the
Project.

"Creating a "Project from a Template" in the Thermo-Calc User Guide or search the
Online Help.

Precipitation Calculator

A Precipitation Calculator allows you to set the conditions for, and perform, a precipitation
calculation. Details about this activity are described in "Precipitation Calculator" on page 32.

Demo Database Packages for the Examples Collection

Both a thermodynamic and mobility database are required to run the Precipitation Module
simulation. If you have a Precipitation Module (TC-PRISMA) license you can run all the
examples as the demonstration database packages are included with your installation. Select
the database packages from the System Definer Configuration window to run a simulation.

If you are using the Precipitation Module in Demo Mode, see "Demonstration
(Demo) Mode" on the next page to learn more.
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Demonstration (Demo) Mode

The Precipitation Module, and two examples (see "Precipitation Module Examples" on
page 18), are available to all Thermo-Calc users but only for simulations with two elements. If
you do not have a license for the Precipitation Module then you are in Demonstration Mode
when using the Precipitation Calculator or Precipitation Simulation template.

See "Network License Restrictions" on page 16 for more information.

Precipitation Simulation Template

When you are in DEMO mode, in the Templates area this is indicated by the text under the
logo.

Precipitation Calculator

If you are experimenting with the Precipitation Calculator in Demo Mode, you may have access
to a variety of databases based on your license. However, you can only define two elements for
a demo simulation.

If you define more than two elements on the System Definer, when you go to the Precipitation
Calculator, the Perform button is unavailable and the tooltip explains why. In this case one of
the chosen elements needs to be removed and then the Perform button is made available on
the Precipitation Calculator.
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Even if you have more than two elements, the Plot Renderer or Table Renderer
Perform button is still available. However, if you click the button and try to run the
simulation the Event Log displays an error message.
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Network License Restrictions
The Precipitation Module (TC-PRISMA) requires a separate license. If you are using a network
client installation of Thermo-Calc, then you may not be able to use it even if you have access to
a license server with a valid network license file. This is because other clients who are part of
your network installation may have checked out all instances of the network license allowed to
run simultaneously.

For users with a network license, you must exit Thermo-Calc to release the license
for other users. The license is checked out as soon as you add a Precipitation
Calculator and remains unavailable to other users until you exit the program.

With a network license, and if as per above you temporarily do not have access to a
license, you are automatically put into Demo Mode. Then the Precipitation
Calculator is available with two elements.

Search the online help or see the Thermo-Calc Installation Guide for more about
network licenses.



Precipitation Module (TC-PRISMA) User Guide

Introduction to the Precipitation Module (TC-PRISMA) ǀ 17 of 67

Selecting the Disordered Phase as a Matrix Phase
The following information is about using disordered Fcc as a matrix phase with the following
thermodynamic and mobility database packages:

l TCAL and MOBAL (Al-based alloys)

l TCCU and MOBCU (Cu-based alloys)

l TCNI and MOBNI (Ni-based alloys)

In the TCNI/MOBNI, TCAL/MOBAL, and TCCU/MOBCU packages, the well-known
order/disorder two-sublattice model is used to describe the Gibbs energy of both FCC_A1 and
FCC_L12. With this treatment, FCC_L12 is becoming FCC_A1 if the site fractions of each
element on both sublattices are identical, which means that FCC_A1 is only a special case of
FCC_L12. Therefore, FCC_A1 is not shown in the phase list on the Phases and Phase Constitution
tab on the System Definer activity and in subsequent equilibrium calculation results. Instead it is
shown only as FCC_L12. The real ordered FCC_L12 is shown as FCC_L12#2.

In precipitation simulations, the matrix phase is quite often the disordered FCC phase. You can
directly select FCC_L12 as the matrix phase and run a simulation. However, the speed is not
optimal due to the sophisticated model used for both Gibbs energy and atomic mobilities. A
better and more convenient way is to deselect FCC_L12 and FCC_L12#2 from the phase list on
the Phases and Phase Constitution tab on the System Definer if the ordered phase is irrelevant
in the alloy under investigation, such as in most Al and Cu alloys. Once these are unchecked (i.e.
not selected), the FCC_A1 phase is available and can later be selected as the matrix phase.

For Ni-based superalloys using the TCNI/MOBNI package, the ordered FCC_L12#2 (gamma
prime) has to be included as the precipitate phase in most of calculations. In this case, you can
select DIS_FCC_A1 from the phase list on the Phases and Phase Constitution tab and then select
it as the matrix phase in the Precipitation Calculator.
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Precipitation Module Examples

Examples 13 and 16 are available to all users. The other examples require a
Precipitation Module (TC-PRISMA) license to calculate and plot results.

All examples use demonstration database packages included with your installation.
You can open the examples from the main menu: File → Open Examples or Help
→ Open Examples.

Ex_13:  Isothermal Precipitation of Al3Sc

This example simulates the kinetics of precipitation of Al3Sc from an FCC_A1 solution phase.
The simulation results can be compared with experimental data collected from Marquis and
Seidman1 and Novotny and Ardell2.

This example is available as a video tutorial on our website and YouTube channel.

Details and Plot Example

System

Database package Demo: Aluminum-based alloys (ALDEMO, MALDEMO)

Elements Al, Sc

Matrix phase FCC_A1

Precipitate phases AL3SC

Conditions

Composition Al-0.18Sc Mole percent

Temperature 350° C

Simulation time 1.0E7 seconds

1E. Marquis, D.. Seidman, Nanoscale structural evolution of Al3Sc precipitates in Al(Sc) alloys, Acta Mater. 49 (2001) 1909–
1919.
2G.M. Novotny, A.J. Ardell, Precipitation of Al3Sc in binary Al–Sc alloys, Mater. Sci. Eng. A Struct. Mater. Prop. Microstruct. Pro-
cess. 318 (2001) 144–154.

http://www.thermocalc.com/training/video-tutorials/
https://youtu.be/MQBtESaDRPk
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Nucleation sites Bulk

Precipitate Phase Data Parameters

Interfacial energy Calculated

Other

Calculation type Isothermal

File name Ex_13_Precipitation_Al-Sc_AL3SC.tcu

Plot Results

Ex_14: Stable and Metastable Carbides - Isothermal

This example simulates the kinetics of precipitation of both stable and metastable
carbides from ferrite phase. It demonstrates that metastable carbides (cementite,
M7C3) may first emerge and then disappear and the stable phase (M23C6)
prevails.

Details and Plot Example

This example uses the Equilibrium Calculator and a property diagram to determine how the
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phases change with temperature. We are interested in the carbide precipitation at 1053K
where only the carbide M23C6 is stable according to the equilibrium calculation. The
Precipitation Calculator is used to do an isothermal calculation of the three phases (cementite,
M23C6 and M7C3) where cementite and M7C3 are metastable phases.

System

Database package Demo: Steels and Fe-alloys (FEDEMO,MFEDEMO)

Elements Fe, C, Cr

Matrix phase BCC_A2

Precipitate phases Cementite, M23C6 and M7C3

Conditions

Composition Fe-0.1C-12Cr Mass percent

Temperature 1053 K

Simulation time 400 000 seconds

Nucleation sites Grain boundaries

Matrix Phase Data Parameters

Grain radius 1.0E-4 m

Precipitate Phase Data Parameters

Interfacial energy Cementite 0.167 J/m2, M23C6 0.252 J/m2, M7C3 0.282 J/m2

Other

Calculation type Isothermal

File name Ex_14_Precipitation_Fe-C-Cr_Cementite-M7C3-M23C6
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Plot Results

Ex_15: Stable and Metastable Carbides - TTT Diagram

In this example, the kinetics of precipitation of both stable and metastable carbides
is calculated from the ferrite phase. It demonstrates that metastable carbides may
first emerge and then disappear and the stable phase prevails.

Details and Plot Example

This example uses the Equilibrium Calculator and a property diagram to determine how the
phases change with temperature. Using this result, the Precipitation Calculator is used to do a
TTT (Time-Temperature-Transformation) diagram calculation of the three phases (cementite,
M23C6 and M7C3) at the grain boundaries.

System

Database package Demo: Steels and Fe-alloys (FEDEMO and MFEDEMO)

Elements Fe, C, Cr

Matrix phase BCC_A2
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Precipitate phases Cementite, M23C6 and M7C3

Conditions

Composition Fe-0.1C-12Cr Mass percent

Temperature 500° to 800° C with 25°C steps

Max. simulation time 1.0E8 seconds

Nucleation sites Grain boundaries

Matrix Phase Data Parameters

Grain radius 1.0E-4 m

Precipitate Phase Data Parameters

Interfacial energy Cementite 0.167 J/m2, M23C6 0.252 J/m2, M7C3 0.282 J/m2

Other

Calculation type TTT diagram

Stop criterium Volume fraction of phase is set to 0.0001

File name Ex_15_Precipitation_Fe-C-Cr_TTT_Cementite-M7C3-M23C6

Plot Results
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Ex_16: Precipitation of Iron Carbon Cementite

Simulate the kinetics of precipitation of carbides from a BCC Fe solution phase. This example is
based on Wert (1949)1.

Details and Plot Example

This example uses two Experimental File Reader activities with the Precipitation Calculator and
an isothermal calculation, to plot the volume fraction of the cementite phase.

System

Database package Demo: Steels and Fe-alloys (FEDEMO and MFEDEMO)

Elements Fe, C

Matrix phase BCC_A2

Precipitate phase Cementite

Conditions

Composition Fe-0.016C mass percent

Temperature 102° C

Simulation time 600 000 seconds

Nucleation sites Dislocations

Matrix Phase Data Parameters

Grain aspect ratio 1.0

Precipitate Phase Parameters

Interfacial energy 0.24 J/m2

Dislocation density 1.5e11m-3

Other

Calculation type Isothermal

1Wert, C. A. (1949). Precipitation from Solid Solutions of C and N in α-Iron. Journal of Applied Physics, 20(10), 943.
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Growth rate model Advanced (on the Options tab)

File name Ex_16_Precipitation_Fe-C_Cemetite

Volume Fraction

Ex_17: Precipitation of γ’ in Ni Superalloys - Isothermal

This example simulates the kinetics of precipitation of γ’ phase from γ phase. The
simulation results can be compared with experimental data collected from
Sudbrack et al.1.

Details and Plot Examples

This example uses three Experimental File Reader activities with the Precipitation Calculator. It
does an isothermal calculation to plot the volume fraction, mean radius and number density of
the cementite phase.

1C.K. Sudbrack, T.D. Ziebell, R.D. Noebe, D.N. Seidman, Effects of a tungsten addition on the morphological evolution, spatial
correlations and temporal evolution of a model Ni–Al–Cr superalloy, Acta Mater. 56 (2008) 448–463.
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DIS_FCC_A1 needs to be selected on the System Definer. Search the online help for
About Ordered Phases in the Precipitation Module (TC-PRISMA) User Guide for
details.

System

Database package Demo: Nickel-based Super Alloys (NIDEMO and MNIDEMO)

Elements Ni, Al Cr

Matrix phase DIS-FCC_A1 (see note above about how to select this phase)

Precipitate phase FCC_L12#2

Conditions

Composition Ni-9.8Al-8.3Cr Mole percent

Temperature 800° C

Simulation time 1 000 000 seconds

Nucleation sites Bulk

Precipitate Phase Data Parameters

Interfacial energy 0.012 J/m2

Other

Calculation type Isothermal

File name Ex_17_Precipitation_Ni-Al-Cr_Isothermal_Gamma-Gamma_prime
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Volume Fraction

Number Density
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Mean Radius

Ex_18: Precipitation of γ’ in Ni Superalloys - Non-isothermal

This example simulates the kinetics of precipitation of γ’ phase from γ phase in Ni-
8Al-8Cr and Ni-10Al-10Cr at.% alloys during continuous cooling. The simulation
results can be compared with experimental results from Rojhirunsakool et al.1 .

Details and Plot Examples

In these examples the Separate multimodal PSD check box is selected on the Plot Render to plot
the mean radius and size distributions of the two compositions.

Plotting the size distribution from the final simulation time of 1470 seconds, you can see there
are several peaks, although these are not completely separated. Use the 'Separate multimodal
PSD' check box on the Plot Renderer to separate the peaks. Then adjust the Valley depth ratio
setting to 0.05 to separate into two peaks as shown in the Ni-10Al-10Cr plot example. You can
experiment with this setting to see how the size distribution evolves with time, for example, try
entering several values as plot times '400 600 1470'.

1T. Rojhirunsakool, S. Meher, J.Y. Hwang, S. Nag, J. Tiley, R. Banerjee, Influence of composition on monomodal versus mul-
timodal γ′ precipitation in Ni–Al–Cr alloys, J. Mater. Sci. 48 (2013) 825–831.
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DIS_FCC_A1 needs to be selected on the System Definer. Search the online help for
About Ordered Phases in the Precipitation Module (TC-PRISMA) User Guide for
details.

System

Database package Demo: Nickel-based Super Alloys (NIDEMO and MNIDEMO)

Elements Ni, Al, Cr

Matrix phase DIS_FCC_A1 (see note above about how to select this phase)

Precipitate phase FCC_L12#2

Conditions

Composition (Ni-8Al-8Cr) Ni-8Al-8Cr Mole percent

Composition (Ni-10Al-10Cr) Ni-10Al-10Cr Mole percent

Temperature 0.23 K/s cooling rate

Simulation time 1470 s (Ni-8Al-8Cr), 3300 s (Ni-10Al-10Cr)

Nucleation sites Bulk

Matrix Phase Data Parameters

Mobility enhancement prefactor 5.0

Precipitate Phase Data Parameters

Interfacial energy 0.023 J/m2

Other

Calculation type Non-isothermal

Separate multimodal PSD for 8Al-8Cr
On the Plot Renderer, the Valley depth ratio is set to 0.05 for both
plots. The number of points is increased to 200 for an average radius
plot.

Separate multimodal PSD for 10Al-
10Cr

On the Plot Renderer, the Valley depth ratio is set to 0.18 for both
plots.

File name
Ex_18_Precipitation_Ni-Al-Cr_Non-isothermal_Gamma-Gamma_
prime
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Mean Radius Ni-8Al-8Cr

Mean Radius Ni-10Al-10CR
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Size Distribution (PSD) Ni-8Al-8Cr

Size Distribution (PSD) Ni-10Al-10Cr
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Using the Precipitation Calculator
In this section:

Precipitation Calculator 32

Precipitation Calculator Settings 32

Precipitation Calculator Plot Renderer 37

Plot Settings 37

Non-Isothermal Simulations 38
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Precipitation Calculator

The Precipitation Calculator is available with two elements if you do not have the
additional Precipitation Module (TC-PRISMA) license. With the add-on module you
can use all available elements.

A Precipitation Calculator allows you to set the conditions for, and perform, a precipitation
calculation. The Configuration window for a Precipitation Calculator has these tabs where you
define the settings:

l Conditions: Set the conditions for your calculation that define the Matrix and
Precipitate phases. Choose the Calculation Type.

l Options: Modify Numerical Parameters that determine how the conditions are
calculated. The Growth rate model can be set to Simplified or Advanced mode.

Example

Precipitation Calculator Settings

The table lists all the settings available from the Conditions and Options tabs.
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You can edit the defaults for some of these settings by going to Tools → Options →
Graphical Mode → Precipitation.

Name Details

Composition unit
Choose from Mass percent, Mole percent, Mass fraction
or Mole fraction.

 Matrix Phase

Phase: Choose a phase from the list. The list is based on the settings for the System Definer.
When setting up your system, choose a matrix phase with kinetic data available in the
database.

Only phases with kinetic data can be selected as the matrix phase. If the list is
empty, go to the System Definer to make sure that both thermodynamic and
kinetic databases are selected and defined. See "System Definer" in the
Thermo-Calc User Guide or search the Online Help.

Click Show details to view these additional settings for the Matrix Phase:

l Molar volume: Choose the default to take the value from the Database or User-
defined to enter another value. Database is available in the list when the molar
volume for the phase is defined in the thermodynamic database.

l Grain radius: Enter a numerical value and choose a unit from the list. The default is
1.0E-4 m.

l Grain aspect ratio: Enter a numerical value. The default is 1.0.

l Dislocation density: Enter a numerical value. The default is 5.0E12 m-3.
l Mobility enhancement prefactor: Enter a numerical value.

l Mobility enhancement activation energy: Enter a numerical value.

Precipitate Phase

Phase: Choose a phase from the list. The list is based on the settings for the System Definer.

The phases available to choose have both thermodynamic and kinetic data. If
the list is empty, go to the System Definer to make sure that both types of
databases are selected and defined. See "System Definer" in the Thermo-Calc
User Guide or search the Online Help.
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Name Details

Nucleation sites: Choose one of the following from the list.

l Bulk, Grain boundaries, Grain edges, Grain corners, or Dislocations. Click to select
the Calculate from matrix settings check box if you want to calculate the number
density of sites from the matrix grain size or dislocation density.

l For Grain boundaries, Grain edges and Grain corners, enter the Wetting angle in
addition to the matrix settings.

l To enter a specific value for the number of nucleation sites, deselect the check box.

Interfacial energy: Choose Calculated to use the estimated value and then enter a different
prefactor value if you want to adjust the estimated value. You can also choose User defined
to enter a value in J/m2.

Click Show details to view these additional settings:

l Molar volume: Choose the default to take the value from the Database or User-
defined to enter another value. Database is available in the list when the molar
volume for the phase is defined in the thermodynamic database.

l Phase boundary mobility: Enter a numerical value.

l Phase energy addition: Enter a numerical value.

l Approximate driving force: Select the check box to include this if simulations with
several compositions sets of the same phase create problems.

Calculation Type

Isothermal
Use an Isothermal calculation type to do a precipitation
simulation at constant temperature. Enter a Temperature
and Simulation time.

Non-isothermal

For the Non-isothermal calculation type, select a
Temperature unit and Time unit from the lists. Enter a
value for the Simulation time.

Click Thermal Profile. Here the Temperature and Time
coordinates of thermal profile points are entered. A
minimum of two points is required. You can also click
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Name Details

Import to add your own thermal profile from an Excel
spreadsheet.

EDIT THERMAL PROFILE WINDOW

TTT diagram

Use a TTT-diagram calculation type to do a precipitation
simulation of the time-temperature-transformation (TTT).

Enter Min, Max, and Step values for the Temperature and
choose a Unit from the list.

Max simulation time: Enter a numerical value and choose
a Unit from the list.

Stop criterium: Choose Volume fraction of phase or % of
equilibrium fraction and then enter a numerical value in
the field. For each temperature, the simulation stops when
the stop criterium is fulfilled or if the maximum simulation
time is reached, whichever happens first.

Numerical Parameters

Max time step fraction
The maximum time step allowed for time integration as
fraction of the simulation time. The default is 0.1.

No. of grid points over one
order of magnitude in
radius

Default number of grid points for every order of magnitude
in size space. The default is 150.0.
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Name Details

Max no. of grid points over
one order of magnitude in
radius

The maximum allowed number of grid points in size space.
The default is 200.0.

Min no. of grid points over
one order of magnitude in
radius

The minimum allowed number of grid points in size space.
The default is 100.0.

Max relative volume
fraction of subcritical
particles allowed to dissolve
in one time step

The portion of the volume fraction that can be ignored
when determining the time step. The default is 0.01.

Max relative radius change
The maximum value allowed for relative radius change in
one time step. The default is 0.01.

Relative radius change for
avoiding class collision

Set a limit on the time step. The default is 0.5.

Max overall volume change
This defines the maximum absolute (not ratio) change of
the volume fraction allowed during one time step. The
default is 0.001.

Max relative change of
nucleation rate in
logarithmic scale

This parameter ensures accuracy for the evolution of
effective nucleation rate. The default is 0.5.

Max relative change of
critical radius

Used to place a constraint on how fast the critical radium
can vary, and thus put a limit on time step. The default is
0.1.

Min radius for a nucleus to
be considered as a particle

The cut-off lower limit of precipitate radius. The default is
5.0E-10 m.

Max time step during
heating stages

The upper limit of the time step that has been enforced in
the heating stages. The default is 1.0 s.
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Precipitation Calculator Plot Renderer
The following is information about the settings available for a Plot Renderer when it is a
successor to a "Precipitation Calculator" on page 32. Also see "Plot Renderer" in the Thermo-
Calc User Guide or search for it in the Online Help.

There are also specific settings related to non-isothermal simulations that are detailed in this
topic.

Plot Settings

Setting/Button Description

Legend option Select whether the diagram’s legend displays On or Off.

Axis variable

Set the state variable you want plotted along the X-axis and the Y-axis.

Select the Separate multimodal PSD check box to enter settings for
Points, Excess kurtosis, Valley depth ratio andMinimum peak.

Axis type
Select the type of axis scale: Linear, Logarithmic, Logarithmic 10 or
Inverse.

Limits

Specify the range along the axis to show in the plot. In the fields, enter
the minimum and maximum values of the axis variable. You can also
determine the step size between the tick marks along each axis.

Select the Automatic scaling check box to allow the program to set the
limits.

Unit (Time X
Axis)

Choose a Unit : Seconds, Hours, or Days.

Add an axis
and Remove
this axis
buttons.

Use these buttons to add additional X- and/or Y-axes to a plot or to
merge plots (to overlay one plot with another in the same diagram).
When merging plots, you define this variable as the Z-axis.
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Non-Isothermal Simulations

When doing non-isothermal simulations it is common that particles grow in different
generations. This results in multi-modal size distributions. To correctly estimate the properties
of these different generations of particles you need to separate the peaks of multi-modal
distributions.

When the Separate multimodal PSD check box is selected on a Plot Renderer activity for the
Precipitation Calculator, the size distribution is evaluated at the given time steps and checked
for multi-modal peaks. These are separated and used to calculate the specified property.

It can be applied on the following plot properties:

l Mean radius

l Size distribution

l Number density

l Volume fraction

Points

This field is available whenMean radius, Number density or Volume fraction is selected as
the Axis variable. Since the evaluation of multi-modality at each time step is costly, you can
specify how many evaluation Points to use. The points are geometrically distributed over the
time scale where nucleated particles are found. The default is 40 points.

Time

This field is available when Size distribution is selected as the Axis variable. Enter one or a
series of numbers in the field, separated by a space, colon (:), semicolon (;) or comma (,).

Example

For example, if you enter 100.0, 1000.0 and 1.0E7 in the field:
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When you click Perform the three times are plotted:

Excess Kurtosis

The Excess kurtosis number specifies the sensitivity when the program evaluates whether a
curve is bimodal or not. The evaluation process calculates the excess kurtosis of the given size
distribution and compares it with the input value. If the value is lower than the given value, the
distribution is split. The excess kurtosis is a statistical measure that measures how peaked and
how heavy tail a distribution has. For the definition used see
http://en.wikipedia.org/wiki/Kurtosis. The default is 25.0.

Minimum Separation Limit (Valley Depth Ratio)

The Minimum Separation Limit is a rough method to prevent that noise or wiggles are
interpreted as different distributions. If a local minima is encountered above this value the
following peak is not interpreted as a new distribution. The valley depth ratio is the ratio of the
minimum separation limit to the peak value. The default is 0.01.

Minimum Peak

Any separated peak below the enteredMinimum peak value is removed. The default is
100000.0.

http://en.wikipedia.org/wiki/Kurtosis
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Theory Overview
Based on Langer-Schwartz theory1 , Precipitation Module (TC-PRISMA) adopts Kampmann-
Wagner numerical (KWN) method2 to simulate the concomitant nucleation, growth, and
coarsening of precipitates in multicomponent and multiphase alloy systems. The KWN method
is an extension of the original Langer-Schwartz (LS) approach and its modified (MLS) form,
where the temporal evolution of the mean radius and particle density over the whole course of
precipitation are predicted by solving a set of rate equations derived with certain assumptions
for the rates of nucleation and growth, as well as the function of particle size distribution (PSD).
The MLS approach differs from the LS with respect to the Gibbs-Thomson equations used for
calculating equilibrium solubilities of small particles. The former applies the exact exponential
form, whereas the latter takes the convenient linearized version. Instead of assuming a PSD
function a priori and working with rate equations for determining only mean radius and particle
density, the KWN method extends the LS and MLS approaches by discretizing the PSD and
solving the continuity equation of the PSD directly. Therefore, the time evolution of the PSD and
its nth moment (0: number density; 1st: mean radius; 3rd: volume fraction) can be obtained
altogether during the simulation. The key elements of the KWN method are the models for
nucleation and growth under the mean field mass balance condition and the numerical
algorithm for solving the continuity equation of the PSD. Coarsening comes out naturally
without any ad hoc treatment.

The key elements of the KWNmethod and their relationship as implemented in the Precipitation
Module (TC-PRISMA).

1J.S. Langer, A.J. Schwartz, Kinetics of nucleation in near-critical fluids, Phys. Rev. A. 21 (1980) 948–958.
2R. Kampmann, R. Wagner, Homogeneous second phase precipitation, in: R.W. Cahn, P. Haasen, E.J. Kramer (Eds.), Mater. Sci.
Technol., Wiley-VCH Verlag GmbH & Co. KGaA, Weinheim, Germany, 1991: pp. 213–304.
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Integration of the Precipitation Module into Thermo-Calc

Precipitation Module (TC-PRISMA) is integrated with Thermo-Calc in order to directly get all
necessary thermodynamic and kinetic information required in the KWN method. For industry
relevant multicomponent alloys, thermodynamic and kinetic databases and calculation tools
have to be used in order to obtain various quantities in the multicomponent models for
nucleation and growth, such as the driving forces for the formation of embryos and their
compositions, the atomic mobilities or diffusivities in the matrix, the operating interface
compositions under local equilibrium conditions, the Gibbs-Thomson effect, and the deviation
from local equilibrium due to interface friction etc. With Thermo-Calc and the Diffusion
Module (DICTRA) as well as the accompanying databases, all these properties and effects can
be calculated without unnecessary and inaccurate approximations.

In the following topics, various models and numerical methods implemented in Precipitation
Module (TC-PRISMA) are introduced. Spherical particles are assumed in the discussion. For non-
spherical and wetting angle effect, see "Homogeneous Nucleation" on the next page.
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Nucleation Theory
Precipitation starts from the nucleation of clusters that can be considered as embryos of new
phases with distinctive structures or compositions. In a perfect single crystal, nucleation
happens homogeneously. In an imperfect crystal or polycrystalline materials, nucleation tends
to occur heterogeneously due to the presence of dislocations, grain boundaries, grain edges,
and grain corners. These imperfections or defects reduce the nucleation barrier and facilitate
nucleation. However, if supersaturation or driving force is very large homogeneous nucleation
is also possible since all sites including those inside a grain can be activated.

l "Homogeneous Nucleation" below

l "Heterogeneous Nucleation" on page 47

l "Nucleation During a Non-isothermal Process" on page 53

Homogeneous Nucleation

The classic nucleation theory (CNT)1 has been extended for the purpose of modeling nucleation
in multicomponent alloy systems. The time dependent nucleation rate J (t) is given by

(1)

where

l Js is the steady state nucleation rate,
l τ is the incubation time for establishing steady state nucleation conditions, and

l t is the isothermal incubation time.

The steady state nucleation rate Js is expressed by

(2)

where

1D. Kashchiev, Nucleation, Butterworth-Heinemann, 2000 and K.C. Russell, Nucleation in solids: The induction and steady state
effects, Adv. Colloid Interface Sci. 13 (1980) 205–318.
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l Z is the Zeldovich factor,

l β* is the rate at which atoms or molecules are attached to the critical nucleus,
l N0 is the number of available nucleation sites (of a particular type) per unit volume,
l ∆G* is the Gibbs energy of formation of a critical nucleus,
l k is Boltzmann’s constant, and

l T is absolute temperature. In the case of homogeneous nucleation, each atom in the
mother phase is a potential nucleation site.

The Gibbs energy of formation of a critical nucleus is expressed as

(3)

where

l σ is the interfacial energy,

l is the molar Gibbs energy change for the formation of the β precipitate of the

critical composition from the α matrix, i.e. the maximum driving force for the α→ β
phase transformation

l is the molar volume of the β precipitate phase.

There are two ways to calculate the nucleation driving force and the critical composition

, as shown in Figure 1 for a prototype binary system. The standard calculation, shown in
Figure 1 (a), is to obtain the maximum driving force by finding the parallel tangent lines or
surfaces passing through the alloy composition of the matrix, which is a routine calculation in
Thermo-Calc. The approximate calculation, shown in Figure 1 (b), is performed by using the
Gibbs energy difference corresponding to the equilibrium composition in the precipitate phase.
It can be used when the standard calculation fails, mostly within a miscibility gap.

Figure 1. Methods to calculate the nucleation driving force and the critical composition .
Figure (a) is a Standard Calculation and (b) an Approximate Calculation.

Figure 1A
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Figure 1B

Nucleation is a stochastic process and can be considered formally as a diffusion process or
Brownian movement in the particle size space. Supercritical nuclei with radius slightly larger
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than the critical radius have a probability of passing back across the free energy barrier and
dissolve in the matrix. The Zeldovich factor Z is a measure of such probability and is related
solely to the thermodynamics of the nucleation process in

(4)

where NA is the Avogadro number and r*, the critical radius, is given by

(5)

The atomic or molecular attachment rate β* reflects the kinetics of mass transport in the
nucleation process and is given by Svoboda et. al.1

(6)

where

l a is the lattice parameter,

l and are the mole fractions of element i at the interface in the precipitate
and matrix, respectively.

l Di is the corresponding diffusion coefficient in the matrix.

The incubation time for an isothermal reaction is

(7)

where θ differs from one derivation to another. The value 2 from Feder et al.2 is adopted.

1Svoboda, J., Fischer, F. D., Fratzl, P., and Kozeschnik, E. (2004). Modelling of kinetics in multi-component multi-phase systems
with spherical precipitates. Materials Science and Engineering: A, 385(1–2), 166–174.
2J. Feder, K.C. Russell, J. Lothe, G.M. Pound, Homogeneous nucleation and growth of droplets in vapours, Adv. Phys. 15 (1966)
111–178.
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Heterogeneous Nucleation

All equations remain the same for the calculation of heterogeneous nucleation rate within the
framework of CNT, but the nucleation energy and available nucleation site are different.

To a first approximation, the nucleation energy is calculated by assuming an effective
interfacial energy for each heterogeneous nucleation site.

Non-Spherical Particles and the Effect of Wetting Angle

"Precipitation Module (TC-PRISMA) References" on page 66

Non-spherical particles have been considered for grain boundary precipitation. Three
morphologies are implemented for grain boundary, grain edge and grain corner precipitation,
respectively, as shown in Figure 1. The parameter that defines the deviation from spherical
shape is wetting angle (or dihedral angle),θ, as described in Figure 2 and taken from Clemm
and Fisher (1955)1.

(a)                                 (b)                                                          (c)

Figure 1. Non-spherical particles (β) that precipitate at grain boundaries ofmatrix phase(α) (a) grain
boundary (two-grain junction) (b) grain edge (three-grain junction) (c) grain corners (four-grain
junction). Images taken from Zang (2004)2.

1Clemm, P. and Fisher, J. (1955). The influence of grain boundaries on the nucleation of secondary phases. Acta Metallurgica, 3
(1), 70–73.
2Zang, L. (2004). Lecture 13: Heterogeneous Nucleation: Effects of Grain Boundaries and Surface Defects. Lecture slides, Salt
Lake City, Utah: The Zang Research Group, The University of Utah. Retrieved from http://www.en-
g.utah.edu/~lzang/images/lecture-13.pdf
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Figure 2. The nucleus at the grain boundary. Image from Clemm and Fisher, 1955.

Some physical parameters, mainly in nucleation models, have to be modified for the effect of
the wetting angle. The following discussions contribute to this effect.

Shape Factors

Following Clemm and Fisher, the eliminated GB area between α — α grains due to the
formation of nucleus of a new phase β is:

(1)

Where r is the radius of curvature of the nucleus. The surface area of the nucleus is:

(2)

and the volume of the nucleus is

V = cr3 (3)

The expression of a, b, c in Equations 1 to 3 for grain boundary (two-grain junction), grain edge
(three-grain junction) and grain corner (four-grain junction) can be found in the paper by
Clemm and Fisher (1955)1.

Critical Radius and Activation Energy

The energy change due to the formation of the new particle is thus

1Clemm, P. and Fisher, J. (1955). The influence of grain boundaries on the nucleation of secondary phases. Acta Metallurgica, 3
(1), 70–73.
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(4)

where σαβ and σαα are the interfacial energy and grain boundary energy, respectively.

Then the critical radius should be

(5)

And the activation energy barrier for nucleation is

(6)

The interfacial energy, grain boundary energy and wetting angle can be related as

(7)

i.e.

(8)

Which can be replaced into Equations 5 and 6.

(9)

(10)

The bulk, spherical precipitation equation is recovered by:

(11)
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so that

(12)

(13)

And also the grain boundary precipitation with spherical shape (with weighting angle 90o)
follows Equations 12 and 13 by .

Other Parameters

Zeldovitch factor

The Zeldovitch factor is modified as

(14)

with Zb the original value, and f the volume factor that is the ratio of the c in Equation 3 to the
spherical shape factor 4π /3.

(15)

Impingement rate

The surface area factor in impingement rate calculation is changed from 4π (r*)2 to b(r*)2.

Nucleation site density

In each time step, the occupied grain boundary area

(16)

is deducted when calculating available nucleation site density.
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Growth rate

The radius r defined in previous equations is the curvature of the precipitate surface (the Big
radius) as shown in Figure 2. It is exactly the definition in the growth rate whose coarsening
consideration relates to the curvature effect. Therefore, the growth rate equation can be
directly used with r being defined here. Again, for bulk, spherical precipitation it automatically
corresponds to the particle radius.

Output

The volume of the precipitate should be calculated appropriately as cr3 with r being the
curvature of the particle surface as defined above. For output of the particle size (mean radius,
critical radius and particle size distribution) in the user interface, it seems better to use the
radius of the eliminated grain boundary area, i.e.

(17)

With a defined in Equation 1.

For example, the size of the precipitate at grain boundary (two-grain junction) is the radius of
the lens shown in Figure 2.

(18)

The Shape and Size of Grains in the Matrix

An example of tetrakaidecahedron approximation of grains



Precipitation Module (TC-PRISMA) User Guide

Theoretical Models ǀ 52 of 67

The number of different nucleation sites is dependent on the shape and size of grains in the
matrix. Assuming all grains are equally large tetrakaidecahedra with the distance between one
pair of square faces as H, and that between the other two pairs as D we obtain the densities ρ2,
ρ1, and ρ0 for the grain boundary area, edge length, and grain corner number respectively in

(19)

(20)

(21)

where A = H/D is the aspect ratio, defining the degree of elongation of the grains.

By default, the aspect ratio is set to 1 and the densities are then the same as obtained by Cahn
(1956)1 Once the densities are known, if taking boundary thickness as one atomic layer, the
available nucleation sites can be calculated by

(22)

where is the molar volume of the matrix phase and NAis the Avogadro number.

For a crystalline material, given a dislocation density ρd, the number of nucleation sites at the
dislocations Nd can be calculated with the same form as in

(23)

1J.W. Cahn, Transformation kinetics during continuous cooling, Acta Metall. 4 (1956) 572–575.
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Nucleation During a Non-isothermal Process

Under a non-isothermal conditions, temperature dependency of key parameters such as
nucleation driving force, solute diffusivities and solute concentrations, etc., have been taken
into account, and are updated automatically during a simulation.

Another important parameter that depends on thermal history is the incubation time, defined
by

(1)

for an isothermal condition. In a non-isothermal process, the exact calculation of the incubation
time requires a solution to the Fokker-Plank equation. In the Precipitation Module, an
approximation approach has been employed to deal with the transient nucleation, which gives
the incubation time as an integral form of past thermal history1 as in

(2)

where

τ is the incubation time, β*is the impingement rate for solute atoms to the critical cluster as
defined in

(3)

and Z is the Zeldovich factor, previously defined in

(4)

but now as a function of τ derived from temperature change.

1H.-J. Jou, P. Voorhees, G.B. Olson, Computer simulations for the prediction of microstructure/property variation in aeroturbine
disks, Superalloys. (2004) 877–886.
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The starting point of the integral (t' = 0 ) is either the starting time if there is an initial
nucleation driving force, or the latest time when the nucleation driving force is vanished.
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Growth
The growth rate models implemented in the Precipitation Module are called Advanced and
Simplified.

The Advancedmodel is proposed by Chen, Jeppsson, and Ågren1 (CJA) and calculates the
velocity of a moving phase interface in multicomponent systems by identifying the operating
tie-line from the solution of flux-balance equations. This model can treat both high
supersaturation and cross diffusion rigorously. Spontaneous transitions between different
modes (LE and NPLE) of phase transformation can be captured without any ad hoc treatment.
Since it is not always possible to solve the flux-balance equations and it takes time when
possible, a less rigorous but simple and efficient model is preferred in many applications. The
simplified model is based on the advanced model but avoids the difficulty to find the operating
tie-line and uses simply the tie-line across the bulk composition.

All models treat a spherical particle of stoichiometric composition or with negligible atomic
diffusivity growing under the local equilibrium condition.

According to the CJA model, the interface velocity ν can be obtained together with interface
concentrations by numerically solving 2n – 1 equations, comprising of the flux balance
equations for n – 1 independent components and the local equilibrium conditions for all n
components as in

(1)

(2)

where

l and are the volume concentrations of component i at the interface in the
precipitate and matrix, respectively,

l Mi is the corresponding atomic mobility in the matrix, and

1Q. Chen, J. Jeppsson, J. Ågren, Analytical treatment of diffusion during precipitate growth in multicomponent systems, Acta
Mater. 56 (2008) 1890–1896.
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l are the chemical potentials in the matrix of the mean-field concentration and at
the interface, respectively.

l is the chemical potential at the interface in the precipitate.

In the above local equilibrium condition, the multicomponent Gibbs-Thomson effect has been
taken into account by adding a curvature induced pressure term to the Gibbs energy of the
precipitate phase.

The introduced effective diffusion distance factor, ξi, for each independent component is given
by

(3)

where

is the so-called dimensionless supersaturation for an individual component, and λi is obtained
via

(4)

Combining Equation 1 and Equation 2, the simplified model is derived in

(5)

where

and ∆Gm is the driving force.
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The interface compositions and are simply taken from the tie line across the
matrix composition.

The non-zero volume correction to the velocity according to Chen and Voorhees1 is taken into
account and it follows as

(6)

where

l υ’ is the corrected velocity,

l <r> is the mean radius and

l NV is the number density.

Also see "Coarsening" on the next page for further discussion of these equations.

1M.K. Chen, P.W. Voorhees, The dynamics of transient Ostwald ripening, Model. Simul. Mater. Sci. Eng. 1 (1993) 591–612.
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Coarsening
Physically speaking, coarsening or Ostwald ripening where big particles grow and small
particles shrink is a process driven by lowering the total surface energy of the system. From a
thermodynamic point of view, the Gibbs-Thomson effect leads to inhomogeneous chemical
potentials in the system if the particle sizes are not uniform. Solutes at the interface in the
matrix near a particle of a radius smaller than critical radius have a higher chemical potential
than that corresponding to the mean concentration of the matrix. As a result, the solutes diffuse
from the precipitate/matrix interface to the inside of the matrix and cause dissolution of the
particle. Conversely, particles with a radius larger than the critical size have lower interface
potentials, and the solutes diffuse to the interface and cause growth of the particles.

Since it is not possible to find a closed form analytic solution for the problem of diffusion-
controlled spherical particle dissolution [Aaron (1970)1], we simply apply the "Growth" on
page 55 equations 1 to 5 with the absolute value of Ωi to calculate the interface velocity for
particles of all sizes.

As can be easily seen, if r < r*, then the Gibbs-Thomson Equation 1 (see "Growth" on page 55)

gives , and a negative velocity results from Equation 2 (see "Growth" on page 55) for
particles having r < r*, which means that they shrink.

Results for particles having r > r* are obtained vice versa. In all situations, when the absolute
values of  Ωi are very small, the steady-state solution for either growth or dissolution are
recovered. In conclusion, the dissolution is treated as the reverse of growth2 , and the
coarsening comes out naturally either together with nucleation and growth or as a dominant
process finally in the course of the evolution of the PSD.

1H.B. Aaron, Diffusion-Limited Phase Transformations: A Comparison and Critical Evaluation of the Mathematical Approx-
imations, J. Appl. Phys. 41 (1970) 4404.
2H.B. Aaron, Diffusion-Limited Phase Transformations: A Comparison and Critical Evaluation of the Mathematical Approx-
imations, J. Appl. Phys. 41 (1970) 4404.
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Continuity Equation
Let f(r) be the PSD of a precipitate phase. N the number of particles per unit volume, <r> the
mean radius and φ - the particle volume fraction, is expressed as

(1)

,
(2)

The time evolution of f(r) follows the continuity as in Langer and Schwartz (1980)1.

(3)

Where v(r) is the growth rate of a particle of size r, and j(r) is the distributed nucleation rate,
which is defined by

(4)

where J is the nucleation rate.

1J.S. Langer, A.J. Schwartz, Kinetics of nucleation in near-critical fluids, Phys. Rev. A. 21 (1980) 948–958.
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Mass Conservation
The matrix concentration is updated at each time step according to the law of mass
conservation. If the alloy concentration, i.e. initial mole fraction of component i in the matrix
phase is X0i, the new concentration Xi can be obtained from the following mass balance shown
in

where

is the mole fraction of element i at the interface in the precipitate phase p of particle
size rp at time t. f (rp, t), v (rp, t) and

Vpm are the PSD function, growth rate, and molar volume of the precipitate phase p,
respectively.

tj is the time at time step j.

Apparently, the new matrix concentration, and thus the updated supersaturation, nucleation
rate, and interface velocity are all functions of the PSD function. This inevitably leads to the
complex non-linear behavior of and great difficulty in solving the continuity equation.
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Numerical Method
Since it is impossible to have a general close form solution, the complex non-linear continuity
equation (see "Continuity Equation" on page 59) of the PSD function has to be solved
numerically. Different numerical methods can be found in literature to solve this equation, such
as finite difference and method of characteristics. In all approaches, the continuous PSD is
discretized into a sufficiently large number of size classes, and then integrated discretely in the
time space. The Precipitation Module utilizes the method of characteristics, where the number
of particles in each size class is kept constant unless particles of the same size have been
nucleated.

An adaptive geometric grid allocation method has been used for particle size discretization
since from nucleation to coarsening the particle size can span several orders of magnitude. In
this approach, the new size grids are allocated evenly in a logarithmic scale and the number of
grid points over one order of magnitude is kept almost constant during the whole process by
class merging and splitting. The time step is controlled by several adjustable numerical
parameters based on mechanistic quantities.

Summarized below are all numerical parameters used in this approach to control either the
size grid distribution or time steps.

Maximum time step fraction

Maximum time step allowed for time integration as fraction of the simulation time.

Number of grid points over one order of magnitude in r

PNr

Default number of grid points for every order of magnitude in size space. The number
determines a default ratio between two adjacent grid points. When there is a need to create
new grid points, such as nucleating at a new radius not covered by the current range of PSD,
this default ratio is used to add these new radius grid points. A larger value of this parameter
enforces a finer grid to allow better numerical accuracy. However, this also comes with
performance penalty, since finer grid in the size space often requires smaller time step to
resolve the calculations.

Maximum number of grid points over one order of magnitude in r
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The maximum allowed number of grid points in size space. This parameter determines a lower
bound limitation for the ratio of every two next nearest grid points in order to maintain
adequate computational efficiency. When a ratio of two next nearest grid points is less than this
limit, the middle grid point is removed and the corresponding size class merged with the two
neighbouring ones.

Minimum number of grid points over one order of magnitude in r

The minimum allowed number of grid points in size space. This parameter determines an upper
bound limitation for the ratio of every two adjacent grid points in order to maintain proper
numerical accuracy. When a ratio of two adjacent grid points exceeds this limit, a new grid
point is then inserted between the two adjacent grids to keep the required resolution.

Maximum relative radius change

Pr

The maximum value allowed for relative radius change in one time step. This parameter limits
the time step according to the following relation, which is controlled by the particle growth:

for r > rdt, where rdtis a cut-off subcritical size defined by the next
parameter. The growth rates of supercritical particles (with r > rc) are always bounded, and
there is a size class and the corresponding growth rate that controls the time step. The
subcritical particles (with r < rc), however, has a mathematical singularity (negative infinity) in
growth rate as approaches 0. This means that the time step can become extremely small if
applying the above criterion to very small subcritical particles. In open literature, several
researchers have tried mathematical transformation to avoid this singularity. Unfortunately,
the transformation also complicates the formulation of the models. The Precipitation Module
implementation uses a simple approach to deal with this issue by defining a cut-off size rdt. All
the particles with r < rdtmay disappear within one time step. rdt is determined by the next input
parameter.

Maximum relative volume fraction of subcritical particles allowed to
dissolve in one time step

Prdt

This parameter represents the portion of the volume fraction that can be ignored when
determining the time step. It is used to calculate the cut-off subcritical size, rdt, for the above
time step control that allows a maximum relative radius changes for all particles:

.
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Relative radius change for avoiding class collision

Pcc

For the supercritical particles, the growth rate is non-linear – usually, it first increases with r
and then decreases after a certain size. In the region(s) with growth rate decreasing with r, it is
possible that the smaller size grid point can catch up with the larger size grid, if the time step is
not controlled. To prevent this from happening, an additional parameter, Pcc, can be used to set
a limit on time step according to the following relation:

for .

Maximum overall volume change

Pv

This parameter defines the maximum absolute (not ratio) change of the volume fraction
allowed during one time step. This parameter is also used in controlling allowable variation in
volume fraction due to the newly created particles within one time step. That is

, where reff and J are effective radius and nucleation rate, respectively.

Maximum relative change of nucleation rate in logarithmic scale

PlogJ

This parameter ensures accuracy for the evolution of effective nucleation rate. It sets a limit on
time step so that the relative change of nucleation rate does not exceed the specified value,
based on the information of previous step. That is , where
nucleation rate J1 and J2 occurs at the beginning and end of ∆tprevious.

Maximum relative change of critical radius

Prc

During the nucleation under high supersaturation, the critical radius can vary dramatically.
Hence, this parameter can be used to place a constraint on how fast the critical radium can
vary, and thus put a limit on time step: .

Minimum radius for a nucleus to be considered as a particle

Prmin
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The cut-off lower limit of precipitate radius. Particles with radius smaller than the value
specified for this parameter are discarded. In reality, the particle cannot be smaller than an
atom; hence, there is no reason to keep track of particles of unphysical sizes.

Maximum time step during heating stages

Phtmax

The upper limit of the time step that has been enforced in the heating stages. The current
algorithm may over-estimate the subsequent time increment when temperature is increased. It
is thus required to reduce this value when the calculation terminates unexpectedly during or
after a heating stage.

Numerical Control Parameters Default Values

Default value for numerical parameters that controls the size grid distribution and time step.

Default value 0.1 200 300 100 0.01 0.01 0.5 0.001 0.5 0.1 5e-10m 1.0s
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Interfacial Energy
Estimation of coherent interfacial energy

Interfacial energy is an important parameter used in precipitation simulations to calculate the
rates of nucleation, growth/dissolution, and coarsening. The value of interfacial energy can
vary dramatically (usually between 0.01 to 2.0 J/m2).

The extended Becker’s model functions to estimate coherent interfacial energy by using
thermodynamic data from existing CALPHAD thermodynamic databases:

where σc is the coherent interfacial energy, ns is the number of atoms per unit area at the
interface, zs is the number of cross bonds per atom at the interface, zl is the coordination
number of an atom within the bulk crystal lattice, and ∆Εs is the energy of solution in a
multicomponent system involving the two phases being considered. (Reference1).

1Becker, R., Die Keimbildung bei der Ausscheidung in metallischen Mischkristallen, Ann. Phys. 424, 128–140 (1938).



Precipitation Module (TC-PRISMA) User Guide

Theoretical Models ǀ 66 of 67

Precipitation Module (TC-PRISMA) References

1. Kampmann, R., and Wagner, R. (1991). "Homogeneous second phase precipitation". In
R. W. Cahn, P. Haasen, & E. J. Kramer (Eds.), Materials Science and Technology (pp.
213–304). Weinheim, Germany: Wiley-VCH Verlag GmbH & Co. KGaA.

2. Langer, J. S., and Schwartz, A. J. (1980). "Kinetics of nucleation in near-critical fluids, "
Physical Review A, 21(3), 948–958.

3. Kashchiev, D. (2000). Nucleation. Butterworth-Heinemann.

4. Svoboda, J., Fischer, F. D., Fratzl, P., and Kozeschnik, E. (2004). "Modelling of kinetics in
multi-component multi-phase systems with spherical precipitates, "Materials Science
and Engineering: A, 385(1–2), 166–174.

5. Feder, J., Russell, K. C., Lothe, J., and Pound, G. M. (1966). "Homogeneous nucleation
and growth of droplets in vapours, " Advances in Physics, 15(57), 111–178.

6. Cahn, J. W. (1956). "Transformation kinetics during continuous cooling", Acta
Metallurgica, 4(6), 572–575.

7. Jou, H.-J., Voorhees, P., & Olson, G. B. (2004). "Computer simulations for the prediction
of microstructure/property variation in aeroturbine disks", Superalloys, 877–886.

8. Chen, Q., Jeppsson, J., and Ågren, J. (2008). "Analytical treatment of diffusion during
precipitate growth in multicomponent systems," Acta Materialia, 56(8), 1890–1896.

9. Chen, M. K., and Voorhees, P. W. (1993). "The dynamics of transient Ostwald ripening",
Modelling and Simulation in Materials Science and Engineering, 1(5), 591–612.

10. Aaron, H. B. (1970). "Diffusion-Limited Phase Transformations: A Comparison and
Critical Evaluation of the Mathematical Approximations", Journal of Applied Physics, 41
(11), 4404.

11. Becker, R. (1938). "Die Keimbildung bei der Ausscheidung in metallischen
Mischkristallen", Annalen der Physik, 424(1–2), 128–140.

12. Wert, C. A. (1949). "Precipitation from Solid Solutions of C and N in α-Iron", Journal of
Applied Physics, 20(10), 943.

13. Clemm, P. , & Fisher, J. (1955). "The influence of grain boundaries on the nucleation of
secondary phases", Acta Metallurgica, 3(1), 70–73.

14. Zang, L. (2004). Lecture 13: Heterogeneous Nucleation: Effects of Grain Boundaries and
Surface Defects. Lecture slides, Salt Lake City, Utah: The Zang Research Group, The
University of Utah. Retrieved from http://www.eng.utah.edu/~lzang/images/lecture-
13.pdf



Precipitation Module (TC-PRISMA) User Guide

Theoretical Models ǀ 67 of 67

15. Chen, Q., Wu, K., Sterner, G., and Mason, P. (2014). “Modeling precipitation kinetics
during heat treatment with CALPHAD-based tools”, J. Mater. Eng. Perform., 23(12),
4193-4196.

16. Hou, Z., Hedström, P., Chen, Q., Xu, Y., Wu, D., and Odqvist, J. (2016). ”Quantitative
modeling and experimental verfication of carbide precipitation in a martensitic Fe-0.16
wt%C-4.0 wt%Cr alloy”, CALPHAD, 53( 6), 39-48.


	Precipitation Module (TC-PRISMA) User Guide
	Contents
	Introduction to the Precipitation Module (TC-PRISMA)
	About the Precipitation Module (TC-PRISMA)
	Help Resources
	Precipitation Module (TC-PRISMA) Options
	Precipitation Simulation Template
	Precipitation Calculator
	Demo Database Packages for the Examples Collection
	Demonstration (Demo) Mode
	Network License Restrictions
	Selecting the Disordered Phase as a Matrix Phase
	Precipitation Module Examples
	Ex_13: Isothermal Precipitation of Al3Sc
	Plot Results

	Ex_14: Stable and Metastable Carbides - Isothermal
	Plot Results

	Ex_15: Stable and Metastable Carbides - TTT Diagram
	Plot Results

	Ex_16: Precipitation of Iron Carbon Cementite
	Volume Fraction

	Ex_17: Precipitation of g’ in Ni Superalloys - Isothermal
	Volume Fraction
	Number Density
	Mean Radius

	Ex_18: Precipitation of g’ in Ni Superalloys - Non-isothermal
	Mean Radius Ni-8Al-8Cr
	Mean Radius Ni-10Al-10CR
	Size Distribution (PSD) Ni-8Al-8Cr
	Size Distribution (PSD) Ni-10Al-10Cr


	Using the Precipitation Calculator
	Precipitation Calculator
	Precipitation Calculator Settings
	Precipitation Calculator Plot Renderer
	Plot Settings
	Non-Isothermal Simulations
	Points
	Time
	Excess Kurtosis
	Minimum Separation Limit (Valley Depth Ratio)
	Minimum Peak


	Theoretical Models
	Theory Overview
	Integration of the Precipitation Module into Thermo-Calc
	Nucleation Theory
	Homogeneous Nucleation
	Heterogeneous Nucleation
	Non-Spherical Particles and the Effect of Wetting Angle
	Shape Factors
	Critical Radius and Activation Energy
	Other Parameters
	Zeldovitch factor
	Impingement rate
	Nucleation site density
	Growth rate
	Output

	The Shape and Size of Grains in the Matrix
	Nucleation During a Non-isothermal Process

	Growth
	Coarsening
	Continuity Equation
	Mass Conservation
	Numerical Method
	Maximum time step fraction
	Number of grid points over one order of magnitude in r
	Maximum number of grid points over one order of magnitude in r
	Minimum number of grid points over one order of magnitude in r
	Maximum relative radius change
	Maximum relative volume fraction of subcritical particles allowed to dissolve...
	Relative radius change for avoiding class collision
	Maximum overall volume change
	Maximum relative change of nucleation rate in logarithmic scale
	Maximum relative change of critical radius
	Minimum radius for a nucleus to be considered as a particle
	Maximum time step during heating stages
	Numerical Control Parameters Default Values
	Interfacial Energy
	Estimation of coherent interfacial energy

	Precipitation Module (TC-PRISMA) References


